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Getting Started 

UNM Confidentiality and Sensitive Information Policies 
Your responsibilities regarding the protection and security of administrative information are outlined in the 
University of New Mexico Policies and Procedures Manual: 

• Responsibility and Accountability for Univ Info & Trans Policy No.2000  
• Acceptable Computer Use    Policy No. 2500 
• Computer Use Guidelines      Policy No. 2510  
• Computer Security Controls and Guidelines.   Policy No. 2520  

Use of University computing services in violation of applicable laws or University policy may result in 
sanctions, including withdrawal of use privilege; disciplinary action up to and including expulsion from the 
University or discharge from a position; and legal prosecution under applicable federal and/or state law.  
Your access is granted based on business need and it is your responsibility to ensure the information 
your access is used appropriately.  Here are some reminders of good data stewardship: 

• Do not share, disclose or store your passwords in an unsecured manner.  
• Do not share confidential and sensitive information with anyone, including colleagues, unless 

there is a business reason.  
• Do not leave your workstation unattended while logged in to administrative information systems. 

You are responsible for any activity that occurs using your password. 
• Do not attempt to access accounts, files, or information belonging to others without their 

knowledge or consent. 
• Do not use your computer account to engage in any form of illegal software copying or other 

copyright infringement. 
• Do not use your account to harass other computer users. 
• Retrieve printed reports quickly and do not leave the reports visible to others.  
• Secure reports containing confidential and sensitive information.  
• Shred documents containing confidential or sensitive information in a timely manner.  

Business Rules  

Monthly Employees (5R)  - Exempt employees are “project” employees in LoboTime who 
record their exception time in LoboTime.  No BAR role required. It is recommended as a best 
practice that exempt employees approve their timecards per their departmental timelines.  

• Exception time requires approval from direct supervisor or from a delegated authority.  
• Departmental Time must be approved and signed off in the LoboTime system for the Monthly 

payroll (5R) by 5:00 pm on the 20th  of each month, or the first working day after the 20th of the 
month if this is a non-business day. Time approval and sign offs to payroll after 5:01pm will not be 
reported until the following pay period.  

http://www.unm.edu/%7Eubppm/ubppmanual/2500.htm
http://www.unm.edu/%7Eubppm/ubppmanual/2510.htm
http://www.unm.edu/%7Eubppm/ubppmanual/2520.htm
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Biweekly Employees (2R) – Non-exempt employees will be using either a PC and/or a 
LoboTime clock to enter time and leave. No BAR role required.  Employees are strongly 
encouraged to approve timecard. 

• Departmental Time must be approved and signed off in the LoboTime system for the Biweekly 
payroll (2R) period by 5:00 p.m. on the Monday after the pay period ends. Time  approval and 
sign offs to payroll will be locked at 5:01pm.  

• Monday, 5:01pm – Thursday, 8:00am, Payroll will run.  
• Comp Time earned in a pay period cannot be taken in the same pay period.  
• You cannot be paid for overtime or compensatory time @1.5 in the same week you have taken 

paid leave.  

Student Employees (2R) – same rules apply for Student Employees as for Biweekly 
• Time entered in ‘hour in tenths’ (6 min increments).  
• While classes are in-session (this includes Fall and Spring breaks) students are allowed to work a 

maximum of 28 hours per week. While classes are not in-session (during Winter break and when 
not enrolled during the summer) students are not to exceed 40 hours per week.Importance and 
Benefits of LoboTime 

Purpose 
It is important that your employees are compensated accurately. To make this happen, you need to 
manage employees’ worked and non-worked hours, as well as attendance issues, in an efficient and 
timely manner. The application supports your ability to perform these tasks so that the data sent to payroll 
is accurate. 

The Payroll Process 

Purpose 
LoboTime automates the payroll process, ensuring that the payroll is processed accurately and on time. 

 

 

 

 

 

 

 

 

HR/Payroll application sends employee 
data to LoboTime 

LoboTime sends employee hours to your 
payroll application 

Departments signs off timecards 

Supervisors and/or Time 
Managers approve timecards 

Employees’ approve timecard data 

Employees’ time is collected and sent to 
LoboTime 

Payroll is processed by your 
payroll application 
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Roles and Responsibilities 

Purpose 
Each employee, supervisor or time manager has responsibilities that are important in the payroll process. 
Each person’s role determines his or her responsibilities and the tasks that he or she performs in the 
application. 

Common Non-Exempt Employee Tasks 
On a daily basis, employees perform the following tasks: 

• Enter time data using a LoboTime clock (terminal) and/or via a computer  
• Approve time 
• Submit requests for future time off 

Common Exempt Employee Tasks 
On a daily basis, employees perform the following tasks: 

• Submit requests for future time off 
• Review timecard for accuracy 

Common Supervisor or Time Manager Tasks 
On a daily basis, Supervisor or Time Managers perform the following tasks: 

• Check for missing punches or other exceptions and add comments 
• Add missing punches 
• Enter and edit schedules 

On a pay-period or as-needed basis, Supervisor or Time Managers perform the following tasks: 

• Monitor timecards to facilitate payroll processing 
• Review timecards for completeness and apply approvals 
• Run reports 

  

 

 

Business practice 
Views are based on roles: 

Time Manager = See multiple supervisors and all employees based on Org’s 

Supervisor = See employees for whom they are Supervisor of Record in Banner 
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Logging On 

Purpose 
The LoboTime log on page provides access to all the features of the application where you perform your 
time and attendance tasks. 

Example 
You, as the department Supervisor or Time Manager, log on to LoboTime at least once a day to review 
and work with your employees’ timecards and scheduling data. 

 

Steps 

1 Access the LoboTime log on page. 

2 Enter your NETID and NETID password in their designated fields. 

3 Select the blue arrow button or press the Enter key on the keyboard. 

 

 

Note 
Passwords may be case sensitive. 

If you or an employee using LoboTime forgets the user name or password,  go 
to https://netid.unm.edu/ for issues regarding your netid or password.      

https://netid.unm.edu/
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Inactivity Timeout and Signing Out 

Purpose 
LoboTime provides security to prevent other people from accessing your information. It also helps keep 
your employees’ information confidential. 

Regaining access after the inactivity timeout 
Inactivity timeout protects sensitive information in the application. If the application does not detect activity 
within a specific amount of time, it attempts to automatically log you off. To regain access to the 
application, you must select Yes when asked to remain logged in. When you regain access, the 
application restores the last page you were viewing. 

 

 

 

Business practice 
The inactivity timeout screen appears if there is no activity for 15 minutes. 

 

Caution 
If you do not select Yes after receiving the inactivity timeout, you are logged out of the 
application. You will lose all unsaved edits.  

Signing Out of LoboTime 
Upon completion of your tasks, you must sign out of LoboTime to ensure that your employees’ 
information remains confidential. 

 

 

Caution 
Selecting the Close (X) button without first signing out can leave your connection to the 
application open, which might allow unauthorized people to view and edit information. 
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Key Parts of the Navigator 
Purpose 
After you log on to LoboTime, your Navigator appears. The Navigator is a customized view of the time 
and labor information that is important to completing your daily work tasks. The Navigator is designed to 
be simple and intuitive with easy-to-use views. You should take a few minutes to get acquainted with its 
navigation features. 

Navigator Components 
Navigator consists of four main components:  Alerts, Workspace, Workspaces Carousel, Workspace Tabs 

 
      Workspace Tabs     Alert Widgets   Workspaces Carousel 
 
 
 

 
 

Workspace 
 

Navigator Component Description 

Alerts A navigator can contain one or more alerts configured to notify you when specific events 
or conditions occur. Because the alerts always appear in your navigator, you’ll know 
immediately if something requires your attention. 

Workspace A navigator can contain one or more workspaces. A workspace is a layout designed to 
accommodate a specific business need. If a navigator has more than one workspace, one 
will be configured as the default or “home” workspace. 

Workspaces carousel If a Supervisor or Time Manager’s navigator is configured to include more than one 
workspace, all workspaces other than the home workspace are listed in the Workspaces 
carousel. You can display additional workspaces in your navigator by selecting them in 
the Workspaces carousel. 
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Navigator Component Description 

Workspace tabs When a workspace is displayed in the navigator, it will have an associated tab. You can 
use the workspace tabs to switch between or to close displayed workspaces.  

 

 

Tip 
LoboTime is a browser-based application. However, you should not use the browser’s 
navigation controls—the Back button on the toolbar, for example. Only use the links inside of 
LoboTime to do your work. 

 

Selecting a Workspace to Display 
If your navigator is configured to provide more than one workspace, select which workspaces to display. 

Steps 

1 To open the Workspaces carousel, 
select the Workspaces tab. 

 

2 Select the arrows to rotate through 
the available workspaces. 

  

3 To select a workspace, select it. 
Note: To close the Workspaces 
carousel without selecting a 
workspace, select the 
Workspaces tab again. 
 
 

The selected workspace opens and a tab for the workspace is added. The Workspaces carousel closes. 
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Switching between workspaces 
After selecting workspaces from workspace carousel, you can switch to a different workspace by 
selecting the associated tab. Note that your home workspace will be indicated by a  in the tab. 

 

Closing a workspace 
To close a workspace and return it to the carousel, hover the cursor over the workspace’s tab and select 
X. 

 
 
Refreshing a tab 
You can refresh the data on a single tab by selecting 

 

The Related Items pane 
Select the arrow in the upper right corner to minimize and maximize the Related Items pane. To retrieve a 
widget from the Related Items pane,select the item and it will open in the main Workspace.  
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Navigating Widgets  

Purpose 
LoboTime pages allow you to perform less common or more complex tasks. You can use widgets in 
LoboTime to complete these tasks. 

The key areas of LoboTime widgets 
Widgets contain three main areas: search tools, the action bar, and the workspace. 

 

 

Areas Description 

Search tools Include: 
• Show field where you can select a specific set of employees 
• Time Period field where you select the timeframe for which you want to view 

schedules and timecard data 

Action bar Allows you to perform tasks to selected employees such as editing punches, approving 
timecards, and other common tasks 

Workspace Work area contains detailed information about the employees in the selected time period, 
as well as the action bar, which contains selections for modifying data 
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Using the tools within a widget 
The Show field allows you to display a group of employees. The default setting for the Show field when 
you log on is “All Home and Transferred-in”, which displays all employees that report to you or are within 
the Org’s you specified within your LoboTime BAR role.  

 
You can use the Show field drop down selections to further refine your selection to include employees in 
a specific group, such as only biweekly (Non-Exempt Employees) or those employees that are within a 
certain EClass.   

 

The Time Period field allows you to set the timeframe you want to view, such as the current pay period or 
a particular timeframe in the past. The time period you select determines what you will see on that page. 

 

Note 

Time Period defaults vary depending on the widget you are using.  Current, Previous or Next Pay 
Period views depend on the type of employee you are viewing.  

• If you are viewing a biweekly employee you will see an hourly timecard with the two week pay 
period you have selected.   

• If you are viewing a monthly employee you will see a project timecard with the month pay 
period you selected. 

• You can also select a Range of Dates, which will restrict the view of all employees selected to 
the dates selected. 

• See page 57 for “Termianted” empoyees business process. 

 
The Action Bar contains tasks that you can perform on the page. Each Action Bar is specific to the page 
that you are currently viewing. 

 

 
 
 
 
 



  Managing Timecards & Schedules for Supervisors & Time Managers 

 

 © 2012, Kronos Incorporated or a related company. All rights reserved.  11 

 

Using the shortcut menu 
When one or more employee records are selected, you can right-select to display a shortcut menu. From 
the menu, you can quickly access four key tools: 

• Timecard 
• Schedule 
• Reports 
 

 
 
 
 
 
 

Tool Description 

Timecard Launches the timecard(s) for the selected employee(s). 

Schedule Launches the Schedule Editor for the selected employee(s). The Schedule Editor is used 
to view and update employee schedules. 

Reports Launches the Reports workspace. If you run a report, it will contain information only for 
the selected employee(s). 

 

Steps 

1 In the workspace area, highlight 
the employees for whom you need 
to access data. 

 

2 
Which system component do you 
want to access? 
• To access timecards for the 

selected employees, right-select 
and then select Timecard 

• To access the Schedule Editor 
for the selected employees, 
right-select and then select 
Schedule 

• To access the Reports for the 
selected employees, right-select 
and then select Reports 

 

 

 

Tip 
There are various ways to select employees:  

• Use the Ctrl key to select more than one employee not listed next to each other  
• Use the Shift key to select all employees listed between two employees, including the two 

employees 
• Select and drag the mouse to select employees 
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Reviewing Employee Data in LoboTime 
Purpose 
LoboTime pages present customized views of employee information in a summarized, easy-to-read 
format so that you can quickly analyze and respond to time, labor, scheduling, and attendance needs. 
The data is displayed for employees with hourly and exempt timecards. 

Example 
You want to look for all employees who have unexcused absences in the current pay period. Use 
Reconcile Timecard to perform this task. 

Steps 

1 From Reconcile 
Timecard Widget from the 
Manager Workspace 

  

2 Select the specific set of 
employees from the Show 
drop-down list. 

 

3 Select the specific time 
period from the Time 
Period drop-down list. 

4 To sort information by one 
or two columns, select the 
column for the secondary 
sort first, and then select 
the column for the primary 
sort. 

  

5 Review the information in 
the Reconcile Timecard 
widget. 
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Exporting Data from LoboTime 

Purpose 
LoboTime pages display critical information in an easy-to-read format. You can export this information to 
other applications, such as Microsoft Excel, where you can analyze and reformat the data. For example, 
you can save labor information in the Reconcile Timecard widget as an Excel file and then open it with 
Microsoft Excel to summarize the data in each column. You can also export the data to a CSV (Comma 
Separated Value) file to make it available to other applications such as Lotus 1-2-3. 

Example 
On a regular basis, you export timecard data to Microsoft Excel to perform further data analysis. 

Step 

1 From the Related Items pane, 
select a LoboTime widget, such 
as Reconcile Timecard. 

 

2 Select Actions > Export. 

 

3 Choose the export option: Excel 
or CSV. 

4 In the File Download dialog box, 
select Open to review the data. 

 

5 (Optional) Select Save. Then, in 
the Save As dialog box, select a 
location for the file and select 
Save. You can review the data by 
opening the file from its new 
location. 
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Locating Employees using QuickFind  

Purpose 
When an employee notifies you about an issue with their timecard, use the QuickFind widget to access 
their timecard. You can use other LoboTime widgets to access timecards, but this page is designed to 
help you locate an employee by their name or ID. If you are unsure of the spelling of an employee’s name 
or know only some of the digits in an employee’s ID number, you can include wildcard characters to help 
you find the employee with only partial information. 

Wildcard 
Character 

Description Example 

     ? 
     _ 
  

A question mark or underline 
character indicates a single 
character occupies a position in 
the search string. 

07?? finds all employees whose ID contains 4-digit numbers 
starting with 07. 
Sm_th finds all employees whose last name starts with “Sm” and 
ends with “th” and has one letter in the center. 

     * 
     % 
  

An asterisk character or a 
percent symbol indicates 
multiple characters can occupy 
a position in the search string. 

*, s* finds all employees whose first name begins with the letter S. 
%1 finds all employees whose ID number ends with the number 1. 

 

Example 
You need to edit the timecard for Ginny BrickGB because she forgot to clock in when she arrived to work 
this morning. To quickly access Ginny’s timecard, access QuickFind and search for all employees whose 
last name begins with “B”. Then select Ginny from the list.  
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Steps  

1 Access QuickFind. 

 

2 Enter your search criteria in the 
Name or ID box.  

 To search by first name, enter 
*,<space> j*. 

 To search by last name, enter s*. 

3 Select Find.  

Generating Reports 

Purpose 
You can generate reports on a daily, weekly, or pay period basis, or any time you need information to 
accomplish your business tasks.  

Example 
For auditing and validation purposes, you want to review all pay code data and totals that have been 
tracked for employees in department/organization for the previous pay period. Generate an Employee 
Transactions and Totals report to review this information. 

Steps 

1 From the Related Items pane, 
select Reports. 
Note: The Reports widget could 
be in your workspace, in the 
Related Items pane or on a Quick 
Link widget 
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Steps 

2 On the Select Report tab, select 
the plus (+) to display a category’s 
contents.  

 

3 Select a report name.  
Note: The report’s description 
appears at the bottom of the 
page. 

 

4 Select the specific time 
employees from the People drop-
down list. 

 
5 Select the specific time period 

from the Time Period drop-down 
list. 

6 Select one or more available 
options to identify the report 
information you need. 
Note: Options can vary by report. 
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Steps 

7 Select an Output Format. 
 
Note: Reports that have (Excel) at 
the end of their names allow you 
to run the report in Microsoft 
Excel Document (.xls) format. All 
other reports can only be run in 
Adobe Acrobat Document (.pdf) 
format. 

 

8 What do you want to do with the 
report? 
• To generate a report, select 

Run Report. 
 

 

9 If you select Run Report, you are 
brought to the Check Run Status 
tab. 
Select Refresh Status. The 
Status column displays Complete 
or Failed once the application has 
finished the report. 
 

 

 

10 To view a report, select a report 
name to highlight it and do any of 
the following: 
• To use menu options, select 

View Report 
• To use mouse options, double-

select the report name 
 

 

11 (Optional) While viewing the report, you can do any of the following: 
• To print the report to a local printer, select File > Print and then select a printer from the list. 
• To send a report in an e-mail message, select File > Send > Page by E-mail and complete the e-

mail message contained in your default e-mail client. 
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Here is an example of an Exceptions report: 
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Setting Up Report Favorites 
If you run the same report with the same options regularly, you can set up the report as a favorite. You 
can then run the report as needed without having to reset your options. Favorites appear as a new 
category at the top of the list.  

Steps 

1 Select the report you want to 
designate as a favorite. 

 

2 Select Create Favorite. 

3 In the Favorite Report field, enter 
a name for the report that has 
meaning for you. 

 

4 In the Author’s Remarks field, 
enter descriptive data. 

5 Select the options that you would 
like to see in the report. 
Note: Options can vary by report. 

6 Select Save Favorite. 

 

7 Confirm that the report is displayed 
in the Favorites category. 
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Steps 

Editing Time and Attendance Data 

Accessing Employees’ Timecards 

Purpose 
Use LoboTime widgets to quickly review and monitor employees' time and attendance data for both 
hourly and exempt timecard employees. From a LoboTime widget, you can open employees’ timecards 
so that you can make any adjustments prior to payroll processing. For hourly employees, changes above 
and beyond what is managed in the exceptions widget are managed in the hourly timecard view. For 
exempt employees, typically changes are managed via the exempt timecard view. 

Example 
In reviewing the Reconcile Timecard widget, you notice that several employees have time and attendance 
exceptions. You open each employee’s timecard to review and adjust the data. 

Steps  

1 From the Related Items pane, 
select Reconcile Timecard.  

2 Select the specific set of 
employees from the Show drop-
down list. Select the correct time 
period from the Time Period 
drop-down list. 
 
 
 

 

3 Select the name of employee(s) 
whose timecards you want to 
review. 

  

4 Right-select and select Timecard. 
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Steps  

5 If you selected more than one 
employee, do one of the following: 
• Select the Next scroll button to 

move to the next employee. You 
can use the Previous scroll 
button to move to a previous 
employee. 

• Select an employee from the 
Name & ID drop-down list. 

 

 

Tip 
There are various ways to select employees in a LoboTime widget:  
• Hold the Ctrl key and select your mouse to select more than one employee not listed next to 

each other.  
• To select a group of employees listed together, use one of these methods:  

o Select on the first employee, then hold the Shift key and select your mouse to 
select the last employee. This will select all employees in-between. 

o Select and drag the mouse to select multiple employees.  

Timecard Overview 
There are three main areas on a timecard; the timecard header, timecard grid, and timecard tabs. 

Hourly (Biweekly Employee) Timecard 
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Exempt (Monthly Employee) Timecard 

 

Timecard Area Description 

Timecard header Displays the following information: 
• Employee’s name whose information appears in the timecard workspace and 

timecard tabs 
• Employee’s identification number 
• Time Period  

Timecard workspace  Displays the following information: 
• Menu bar that contains selections for performing timekeeping tasks 
• Grid containing dates for the selected time period 
• Time entry totals, including shift, daily, and cumulative amounts 

Shift Total — Calculated total hours of all shifts worked on the selected day (excluding 
totals for non-shift items such as pay codes)  
Daily Total — Calculated total hours of the selected day, including pay codes 
Cumulative — Cumulative total up to and including the selected day 
All — Calculated total hours for the entire visible time period 
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Timecard Area Description 

Timecard tabs 
 

Display additional information about how Kronos tracks employee hours. Three default 
tabs appear: 
• Totals & Schedules — Refered to as the “Totalizer.” The first tab at the bottom of the 

timecard workspace. The area on the left displays the timecard totals. The area on the 
right displays the Schedule for the selected time period. 

• Accruals — Displays accrual codes and available balances based on the date 
selected in the timecard workspace. 

• Audits — Lists all time punch or amount corrections made to an employee’s timecard 
and approvals made by a Supervisor or Time Manager.  

Note: Additional tabs will appear based on actions you perform. For example, the 
Approvals & Sign Offs tab appears when you approve an employee’s timecard. 

Visual indictors appear on a timecard when an exception occurs. For example, an employee might forget 
to clock in or out, which causes a missed punch exception. An employee might clock in early or late, 
which causes a punch exception. 

 

Visual Indicator Description 

Blue-bordered date An excused absence for the day, such as Vacation, Bereavement, or Jury 
Duty 

Red-bordered date An unexcused absence for the day 

Red-bordered punch An exception, such as a late or early punch, or a short or long break 

Green-bordered punch Exception has been marked as reviewed 

Solid-red cell A missed punch 

Purple text A transaction that was added by the LoboTime  application  

Yellow note icon in the top 
corner of a cell 

One or more comments are attached to the punch or amount 
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Refreshing and Saving Data in Timecards 

Purpose 
When you add and modify timecard data, LoboTime displays your edits but does not save them 
automatically. You must tell the application to save the data. Prior to saving your data, you can decide 
whether the edits are what you want. 

Example 
You have been editing the timecard of Rick CarterSU when you realize that you entered the wrong 
information. You cancel the edits, enter the correct information and save the timecard. 

Canceling Edits 

Steps 

1 Perform one or more edits on a 
timecard. Notice the visual 
indicators that indicate unsaved 
data. 

 

2 Select Actions > Refresh. 

  

3 Do you want to cancel your 
changes? 
• To cancel your changes, select 

Yes 
• To keep your changes, select 

No 
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Saving Edits 

Step 

1 Perform one or more edits on a 
timecard. Notice the visual 
indicators that indicate unsaved 
data. 

 

2 Select Save. Review the employee’s timecard to ensure that the visual indicators no 

longer appear, validating that your information was saved. 

Calculating 
Step 

1 Perform one or more edits on a 
timecard. Notice the visual 
indicators that indicate unsaved 
data. 
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Step 

2 Select Actions > Calculate 
Totals. 

  

3 Notice that the red flag no longer 
appears, but the Timecard title still 
indicates unsaved data. 

  

 

Visual Indicator Description 

Timecard title in orange with asterisk Unsaved edits 

Red flag in the Totals & Schedule tab Totals are not up-to-date 

Overriding Punches 

Purpose 
When employees punch in or out of their shifts, they occasionally mislabel an in punch as an out punch or 
an out punch as an in punch. To calculate the employee’s worked time correctly LoboTime needs to have 
the same number of in punches as out punches. If they do not match, override the incorrectly labeled 
punch to correct it. 

Example 
Julie AdamsPTNE failed to punch in on the first Saturday of the current period, which was an 
unscheduled day.  She did punch out. Without a schedule LoboTime labels the first punch as an in punch. 
You override the in punch to change it to an out punch. 
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Steps 

1 In the timecard, select the punch 
you want to override. Select 
Punch > Edit. 

  

2 Select the punch type from the 
Override drop-down list. 
 
 
 
 
 
 
 
 

  
3 Select Actions > Calculate Totals 

to preview change 

4 Select OK. 

5 Select Save.  

Actionable Exception Handling  
The following table lists and describes the action links you can use to resolve exceptions in hourly 
timecards. 

Action Button Description 

Save Saves changes to the database. Title of the page becomes orange when there are 
unsaved changes have been made. 

Timecard Allows you to view the hourly timecard view. Menu link will be greyed out if currently in 
the Timecard view. 

Schedule Allows you to view the employee’s schedule. Menu link will be greyed out if currently in 
the Schedule Editor view. 

Reports Allows you to view run employee reports. Menu link will be greyed out if currently in the 
Reports view. 

Mark as Reviewed Select Punch > Mark as Reviewed  
Allows you to identify exceptions that you have already addressed and on which you do 
not plan to take further action. The color of the exception changes from red to green. 
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Unmark as Reviewed Select Punch > Mark as Reviewed  
Once an exception has been Marked as Reviewed you will have the ability to reverse the 
Review if needed.  The color of the exception changes from green back to red. 

Comment Opens the Add Punch Comment dialog box. Select a comment and, optionally, add a 
note. 

Remove Allows you to remove punches. 

Viewing Accrual Balances in Timecards 

Purpose 
Before you enter non-worked time, confirm that the employee has accrued enough hours. The Accruals 
Reporting Period tab displays the employee’s current and projected accrued times.  

Example 
Julie AdamsPTNE would like to take an annual leave day on September 2nd. Before entering the time off, 
check the employee’s vacation balance on the Accruals Reporting Period tab. 

  

Column Description 

Type The code that identifies and holds the type of accrual balance, such as Annual or Sick Leave 

Reporting Period The accrual reporting period 

Units  The unit that is associated with an accrual code, measured in days or hours 

Opening Balance  The accrual balance as of the first date in the Reporting Period column 

Earned to Date The total amount of time earned up to the last date selected in the Schedule Editor 

Taken to Date  The total amount of time taken up to the last date selected in the Schedule Editor 

Available The balance that is available as of the date selected in the Balance as of field 

Planned Takings  The total amount of time scheduled to be used (taken) from the end of the selected schedule 
period through the end of the Reporting Period 

Pending Grants The total amount of time scheduled to be granted (fixed grants) from the end of the visible 
schedule period through the end of the Reporting Period 

Ending Balance The accrual code balance as of the last date in the Reporting Period, including Pending 
Grants and Planned Takings 
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Managing Requests 

Processing Employee Requests Using Manage My Requests Widget  

Purpose 
The Manage Requests widget summarizes all requests in one window and provides all supporting 
information needed to process requests right from the same screen. Requests can come from employees 
or other Supervisor or Time Managers, for example, manager delegation requests. In the Manage 
Requests widget, Supervisor or Time Managers can process requests one-at-a-time or simultaneously 
process multiple requests of the same type. Supervisor or Time Managers can also both filter the list of 
requests displayed in the widget and sort the list by column. 

 

 

Component Description 

Request type This field enables Supervisor or Time Managers to filter the requests that are 
listed based on the request type. 

Request status This field enables Supervisor or Time Managers to filter the requests that are 
listed based on the request status. 

Request tabs These tabs display different information relevant to the selected request. 

Request actions These buttons enable Supervisor or Time Managers to perform actions related 
to processing employee requests. 

Example 
An employee has requested a day off. You want to view the employees’ requests and approve the 
request if the employee has the time available. 
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Steps 

1 To access the Manage Requests 
widget, choose one of the 
following: 
 
• Select a request type in the 

Requests alert list. 
• Select Manage Requests from 

the Related Items pane.  
 
Note: If you select this method, 
close the Related Items pane 
when you’re done to maximize the 
space for your widget(s). 

 

 

2 In the Manage My Requests 
widget, select the 
Maximize/Restore icon to expand 
the widget to its full size. 

 

3 Confirm the default values or 
select new values in the Time 
Period and Show fields. 

 

4 Confirm the default values or 
select new values in the Request 
type and Request status fields. 

 

5 Select a request to process.  

6 To approve, refuse, or perform 
another action on the selected 
request(s), select the applicable 
button. 

 

7 In the dialog box that appears, 
verify the displayed information 
and, if applicable, select a 
comment from the Comments 
drop-down list and/or enter text in 
the Notes field. 
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Steps 

8 Select the button to confirm the 
action you wish to perform. 

 

Processing Time-Off Requests Using Schedule Editor 

Purpose 
Employees can submit time-off requests using the My Requests Calendar in the application. These 
requests are stored in the Requests tab of the Schedule Editor, where you can evaluate them and 
approve or reject them. This feature provides a consistent, easily accessible way for employees to 
request or cancel time off, as well as a quick way for Supervisor or Time Managers to evaluate and 
respond to requests. 

Example 
Jean HarmonySC submits a request for time off on a day when she is scheduled to work. You review the 
Requests tab, verify that she has the time to take, and then approve the request. 

Steps 

1 From the Related Items pane, 
select Schedule Editor. 

 

2 Select the Requests tab. 

3 From the Request For drop-down 
list, select an option and then 
select Reload. 
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Steps 

4 Select the request and right-select 
to access the shortcut menu. 

  

5 Are you approving or rejecting the 
request? 
• To approve the request, select 

the Approved option. 
• To reject the request, select the 

Refused option. 

6 Select Save.  

Requesting Time Off Using My Calendar  

Purpose 
The My Calendar displays your schedule for the current pay period as well as previous and subsequent 
pay periods. It provides a consistent, easily accessible way to request or cancel time off. LoboTime 
forwards the requests to your Supervisor or Time Manager to handle appropriately. 
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Example 
Your childcare provider will be unavailable next Thursday and Friday and you need to take the days off. 
Submit a time off request for eight hours of vacation for next Thursday and Friday. 

Steps 

1 From the Workspaces carousel, 
access Exempt Employee. 
Note: Exempt Employee could 
be in a workspace or in the 
Related Items pane.  

 

2 Select the specific time period 
from the Time Period drop-down 
list. You can also adjust the width 
of the calendar view. Then select 
Apply. 

3 Select the date in the calendar 
when you want the time off to 
begin. 

 

4 Select Request Time Off. 
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Steps 

5 Confirm that the Start Date is 
correct. 
Select the End Date calendar icon 
and select the date when you want 
the time off to end. 
NOTE: Dates entered should NOT 
span over a weekend.   

 

6 Confirm that the Pay code field is 
correct. 

 

7 Enter Length 
NOTE: Hours entered are PER DAY.  For example if 3 consecutive 
days are requested enter 8.0 in the length field. 

8 Select Submit. 

 

10 The request has been submitted 
for approval and appears in the 
employee’s calendar with the 
Submitted (arrow) icon. 
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Steps 

Managing Exceptions for Employees 

Using Genies and Alert Icons to Manage Exceptions 

Purpose 
Your navigator is configured to receive alerts, and if one of your employees has triggered a time data 
exception that requires your attention, you will see an Alerts icon at the top of your navigator when you 
log in. 

 

Hover your cursor over the Alert icon to see a list of the exceptions. Select an employee from the list to 
view the details of the exception. You will be brought to the Time Data Exceptions widget. 
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Viewing Exceptions  

Purpose    
When hourly employees forget to punch, or punch in early or late, their pay can be impacted. Therefore, it 
is your responsibility to resolve any discrepancies to make sure that employees get paid correctly. In 
addition, some organizations restrict payroll processing if issues are not resolved. Exception widgets 
allow you to recognize and resolve the most common types of exceptions. 

The Summary View 
In the summary view, the Time Data Exceptions widget displays a list of your employees for the time 
period and HyperFind selected at the top of the widget. It organizes the employee exceptions according 
to your organization’s “exception type” preferences. 

 

Recognizing common exceptions and visual cues in Time Detail view 
Visual cues help Supervisors or Time Managers quickly understand time data issues that require their 
immediate attention. The following table summarizes the most common visual cues. 

Description Visual indicator 

In or Out punch cell is filled with solid red Missed in or out punch 

In or Out time displays in red text Early in or out/Late in or out 

Date displays in red text Unexcused absence 

In or Out punch cell is filled with solid red Double-punch 

In or Out punches are in green text Punch has been marked as reviewed or justified 

In or Out punches are in purple text Punch has been added by LoboTime 
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Missed In/Out Punch Example  

Late In/Out Example on 3/10 

 

Unexcused Absence Example on 3/13 
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Double Punch Example on 3/9 
Remove the second pumch at 9:01AM by selecting the cell > deleting the entire contents > Save 

  

Double Punch Example 
For every In punch there needs to be a corresponding Out punch. Often, double-punches are identified as 
a missing punch because the extra punch does not have a corresponding punch. 

Attaching Comments and Notes to Punches 

Purpose 
Comments are predefined descriptive phrases that you attach to a punch or amount to provide additional, 
useful information about that transaction. You can attach as many comments as needed to explain the 
punch or amount. You can also add free-text notes to comments for additional clarification. 

Example 
On Monday of the current pay period, Julie AdamsPTNE arrived late to work because she had car 
problems. You want to add a comment to the employee’s 10:50 A.M. punch as a reminder of why the 
employee did not work her entire shift. From the Reconcile Timecard widget, access the employee’s 
timecard. Then add the Late-Car Problems comment to the employee’s 10:50 A.M. punch for Monday of 
the current pay period. 

Steps 

1 In the timecard detail view, select 
the cell containing the exception.   

2 Select Comment. 

3 From the list of comments, select 
to select the comment you want to 
add. 

 

4 (Optional) Too add a note, select 
in the Note section and enter text. 

5 Select OK. 

6 Select Save.  
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Steps 

7 Confirm that the note icon 
appears in the time detail view.   

 

 

 

Business best practice 
Attach comments to any edit made in an employee’s record.  

 

 

Note 
All comments may be seen by other parties including the employee and other managers and 
are historical records in the employee’s time detail report. Keep comments and notes in a 
respectful, factual and professional.  

Effective Use of Comments in LoboTime 
 
In the Attaching Comments and Notes to Punches section of this guide, you were shown how to 
functionally use comments when editing a punch. In LoboTime the Supervisor or Time Manager has the 
ability to add comments when they are: 
 

• Editing a punch 
• Approving or refusing a leave request 
• Editing a shift 
• Editing a pay code 

Functionally adding a comment and a note in each of the above actions can be found in section named 
Attaching Comments and Notes to Punches. Below is a guide to assist you in selecting the appropriate 
comment in each of these actions. 
It is important to remember that any time you are making a change to an employee’s time card, the 
change should be documented for tracking and auditing purposes. After selecting a comment from a 
supplied list of appropriate comments, you also have the ability to add a note in a text box. The note is 
your opportunity to add narrative documentation furthering explaining why you were specifically taking an 
action. Be aware your comments and notes are viewable by the employee and auditors.  
 
Comments Available when Approving, Returning, or Refusing a Leave Request 
 
When submitting a request, the employee’s view will have “See Notes” default into the comment section 
and the employee should be advised to use the Notes text box to write an explanation of the request.  

 

Comment Description  Example 

Conditional 
Approval 

Request is Approved by with conditions Leave Request is approved but they are 
expected to bring a note from their Doctor. 
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Comment Description  Example 

Coverage Issue Request is refused due to a coverage 
issue 

Multiple employees have requested leave 
at the same time, which will not leave 
adequate coverage for the department. 

Excessive AL 
Usage 

Request is refused due to employee’s 
excessive use of leave. 

The employee has requested every Friday 
off for the past month.  

See Note Generic comment that is used when there 
are no specific comments available for the 
reason that a leave is approved or refused.  

The employee requests A/L for a death 
covered by the Bereavement Leave and 
the Manager plans on editing the pay code 
to change it to Other Paid Leave. The 
Manager will document in the notes 
section. 

Comments Available when Editing a Pay Code 
(When a person hasn’t punched in and/or out in order to ensure the person is paid and the appropriate 
pay code is specified) 

Comment Description  Example 

Bereavement When an employee is on “other paid leave” 
due to death of a family member. 

The employee could not request 
Bereavement leave in the system. The 
manager inputs pay code “other paid 
leave” and chooses “Bereavement.”  

Conference  When an employee is at a conference 
during normal work schedule or during 
regular work hours. There are additional 
provisions. (Contact your HR Consultant 
for guidance in paying non-exempt 
employees while attending a conference). 

Choose this comment when the employee 
is unable to punch. 

FMLA When an employee is on approved FMLA 
with applicable pay code  

The employee may use FMLA with or 
without paid sick and annual leave. i.e. 
employee is using sick leave concurrently 
with FMLA. If an employee has exhausted 
all sick and annual leave the FMLA 
comment would be used in conjunction 
with LWOP. 

Jury and Court Duty When an employee is in jury duty or at 
court if it is during the regular work hours  

Use in combination with “other paid leave” 
when the employee is on court or jury duty. 

Marriage When the employee is out during regular 
work hours for his/her own wedding 

Use in combination with “other paid leave” 
when the employee does not punch 
because he/she is getting married during 
his/her regular schedule. 

No Show-
Unexcused 
Absence 

When the employee is out and has not 
received prior authorization  

Use in combination with “LWOP” when the 
employee misses a punch because he/she 
did not come in and did not call. 

Per Supv –Previous 
Pay Period Hours 

When an employee who is not showing up 
in Lobotime has worked 

Use in combination with appropriate hours 
and pay code to make an edit to a missed 
punch. 

Standby When an employee has been placed on 
standby 

Use to pay an employee at the standby 
rate when he/she has been officially 
placed on standby with the expectation 
that he/she may need to come in. 
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Comment Description  Example 

Training and 
Education 

When a person misses a punch because 
he/she is at a training session or is taking 
an authorized course during UNM time 

Use to capture the amount of time that an 
employee is at training or taking an 
authorized course during work time. This 
would be regular time as opposed to “other 
paid leave.”  

University or Dept 
Closure 

When the employee misses a punch 
because the University or department 
needs to close 

This situation could occur because of 
department closure due to facility mishap 
i.e. flooding or University closure due to 
inclement weather. Use in combination 
with “other paid leave.” 

Voting Time When a person has to vote during 
regularly scheduled work hours 

Use in combination with “other paid leave.” 

See Note Below Generic comment that is used when there 
are no specific comments available for the 
reason that a pay code is being edited.  

The Manager or Supervisor wants to 
document an edit to a pay code that is not 
covered by the available comments and 
will add a note for documentation. 

Comments Available when Editing a Punch 
 

Comment Description  Example 

Call Back When a person needs to come back to the 
workplace to work after having left for the 
end of the day 

Use when a physical plant employee is 
called into work due to a flood in a 
building.  

Double Punch When the employee punches several 
times in error. 

Use when employee inadvertently swipes 
out for lunch two times in a row.  

See Note Below Generic comment that is used when there 
are no specific comments available for the 
reason that a punch is being edited. 

The Manager or Supervisor wants to 
document a punch edit that is not covered 
by the available comments and will add a 
note for documentation. 

Comments Available when Paying from Schedule 
(When a person hasn’t punched in and/or out in order to ensure the person is paid) 

Comment Description  Example 

Badge Reader Error 
& Forgot ID 

This enables the manager to a supporting 
comment for adjusting an employee’s 
punch.  

Use when the time clock is unable to read 
badge and the employee can’t remember 
his/her UNM ID. 

Building Locked This enables the manager to a supporting 
comment for adjusting an employee’s 
punch. 

Use when the employee reports for work 
but is unable to get into the building at 
his/her regular work time to clock in. 

Clock Inoperable This enables the manager to a supporting 
comment for adjusting an employee’s 
punch. 

Use when the clock is malfunctioning until 
the repair or re-setting can be made. 

Forgot to Punch This enables the manager to a supporting 
comment for adjusting an employee’s 
punch. 

Use when the employee did not punch in 
or out. The manager should discuss the 
matter with the employee and edit the 
punch with the correct time the employee 
left/returned. 
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Comment Description  Example 

Meeting This enables the manager to a supporting 
comment for adjusting an employee’s 
punch. 

Use when the employee is unable to 
punch in or out because he/she is in a 
meeting away from the time clock or P.C. 

New Employee This enables the manager to a supporting 
comment for adjusting an employee’s 
punch. 

Use when a new employee starts in the 
department and has not punched in or out 
because he/she is not yet on Lobotime. 

No Badge & Forgot 
ID 

This enables the manager to a supporting 
comment for adjusting an employee’s 
punch. 

Use when the employee forgets his/her 
badge and can’t remember his/her UNM 
ID. 

Resigned This enables the manager to a supporting 
comment for adjusting an employee’s 
punch. 

Use when someone resigns and walks off 
the job without punching out. 

Worked After Punch This enables the manager to a supporting 
comment for adjusting an employee’s 
punch. 

Use when an employee ends up having to 
work after he/she punched out. 

Worked Before 
Punch 

This enables the manager to a supporting 
comment for adjusting an employee’s 
punch. 

Use when an employee ends up working 
before he/she has punched in. 

See Note Below Generic comment that is used when there 
are no specific comments available for the 
reason that a Manager is paying from 
schedule.. 

The Manager or Supervisor wants pay 
from schedulet that is not covered by the 
available comments and will add a note for 
documentation. 

Comments Available when Editing Shift 
(This is for a temporary change to shift for the day or week.) 

Comment Description  Example 

Accommodation When the employee needs a temporary 
change to shift for accommodation (Please 
contact your HR Consultant for further 
guidance.) 

Use when an employee has to come in 
late due to medical issue as approved 
through accommodation request. 

Coverage Issue When the business needs require the 
employee works a different schedule. 

Use when an employee is required to stay 
past his/her schedule to help with 
coverage. 

Employee Request When the employee requests to work a 
different schedule due to personal needs 

Use when the employee elects to come in 
late or leave early (with management 
approval). 

FMLA When the employee needs a temporary 
shift for Family Medical Leave. (Please 
contact your HR Consultant for further 
guidance.) 

Use when an employee has to come in 
late due to medical issue as approved 
through a Family Medical Leave request. 
 

Management 
Request 

Managing employee’s hours based on 
appointment percentage 

Use when the employee has to flex his/her 
schedule to ensure he/she does not work 
beyond appointment percentage 

See Note Below Generic comment that is used when there 
are no specific comments available for the 
reason that a shift is being edited. 

The Manager or Supervisor wants to 
document a shift edit that is not covered by 
the available comments and will add a 
note for documentation. 
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Marking/Unmarking Exceptions as Reviewed 

Purpose 
Once you have reviewed an exception and resolved it to your satisfaction, you can mark the exception as 
having already been reviewed. Once you have marked an exception as reviewed, the exception no longer 
appears on any Exception widget. The exception remains visible in the timecard and in certain widgets, 
but will be outlined in green. Additionally, at any time you can choose to unmark an exception as 
reviewed. 

Example 
On Monday of the current pay period, Julie AdamsPTNE arrived late to work because of car problems. 
You added a comment to the employee’s 10:50 A.M. punch as a reminder of why the employee did not 
work her entire shift. Now you want to mark the exception as reviewed so that you do not re-check it 
again at a later date. 

Steps 

1 In the timecard detail view, select 
the cell containing the exception. 

 

2 Do you want to mark an exception 
as reviewed, or unmark an 
exception as reviewed? 
• To mark an exception as 

reviewed, select Mark as 
Reviewed. 

• To unmark an exception as 
reviewed, select Unmark as 
Reviewed. 

Note: Mark as Reviewed is only 
available for exceptions that have 
not already been marked as 
reviewed. Additionally, Unmark as 
Reviewed is only available for 
exceptions that have already been 
marked as reviewed. 

 

3 Review the results. 
 

 

 

 

Business practice 
Departments are strongly encouraged to review exceptions on a daily basis.   
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Adding Missed Punches 

Purpose 
An employee might forget to punch in or out. When this happens, a solid-red box appears in the missed 
In or Out cell. The application accepts multiple formats for entering punches in a timecard. 

Example 
Julie AdamsPTNE notified you that she forgot to enter punches on Wednesday of the current pay period. 
The employee started her shift at 9:00 A.M. and ended her shift at 2:00 P.M. From the Timecard view, 
enter the In punch and Out punch by selecting in the cell marked with a red box and manually enter the 
time. 

Steps 

1 In the timecard detail view, select 
the cell containing the exception.   

2 In the Add Punch dialog box, 
confirm the date.  

3 From the Insert drop-down list, 
select the applicable punch 
option: 
• In Punch 
• Out Punch 
• In and Out Punches 

4 Select Save. Confirm that the 
exception no longer appears in 
the Reconcile Timecard Genie 
and in the Timecard views. 

 

 

 

 

Business practice 
You must fix all Missed Punches before timecards can be signed off and Payroll successful 
runs. 

Removing Punches 

Purpose 
As a rule, you should not remove punches from timecards because they represent actual times that 
employees started and stopped working. However, there are some exceptions to this rule. For example, 
an employee might punch twice when starting or ending a shift. When this occurs, you will want to 
remove the extra punch.  

Example 
Steven KnoxSN could not remember if he punched in at the beginning of his shift on Monday of the 
current pay period. He punched in a second time to ensure that he recorded his start-of-shift time. While 
reviewing the employee’s time detail, you notice that two In punches appear for the employee’s start of 
shift on Monday. You want to remove the employee’s second In punch at 8:31 A.M. From the employee’s 
time detail, remove the 8:31 A.M. punch for Monday using the Remove feature. 
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Steps 

1 In the timecard detail view, select 
the cell containing the exception.   

2 Select Remove. 

3 Select Save. Confirm that the 
exception no longer appears in 
the time detail view. 

 

Applying a Work Rule Transfer for Labor Overrides 

Purpose 
Each employee is assigned a primary labor account and default work rule. During the normal workday, all 
worked and non-worked hours are charged to this assigned labor account. Occasionally, you may need to 
transfer the employee to another labor account or work rule. You need to record the transfer in the 
application so that the right labor account is charged and the right work rule is applied. You or the 
employee can record the transfer directly in the schedule or timecard. 

Example 

Steps 

1 From the Related Items pane, 
select Reconcile Timecard.  

2 Select the specific set of 
employees from the Show drop-
down list. Select the specific time 
period from the Time Period 
drop-down list. 

 

3 Select the employee, right-select 
and then select Timecard.  

4 Select the drop-down arrow in the 
Transfer cell between the In and 
Out punch cells for the date you 
want to record the transfer. 

 

 

5 Does the work rule appear in the 
Transfer list? 
• If yes, select the work rule and 

continue to step 8. 
• If no, select Search and 

continue to the next step. 
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Steps 

6 To transfer hours to another 
index, select the index from 
the Available Entries box. 
 
The search can be refined 
in the Name or Description  
box.  Enter the first couple 
of digits of index code, then 
use wildcard  * to complete 
search. 
 
For example:  enter 925* 
Hit search 
All available index codes 
that begin with 925 will 
appear. 
 

  

7 Select OK.  

8 Select Save. 

 

Transferring Overtime to Comp Time Earned 

Purpose 
Per University policy an employee may be granted compensatory time off in lieu of overtime pay.  If the 
supervisor and the employee have a written agreement, complete a transfer to move overtime hours 
earned to compensatory time earned at time and a half. 

Example 
Rick CarterSU has worked two hours of overtime in the second week of the current pay period.  Complete 
a transfer to move the overtime hours to compensatory time earned at time and a half. 

Steps 

1 From the Related Items pane, 
select Reconcile Timecard.  

2 Select the specific set of 
employees from the Show drop-
down list. Select the specific time 
period from the Time Period 
drop-down list. 

 

3 Select the employee, right-select 
and then select Timecard.  
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Steps 

4 Right select the Overtime pay 
code line in the Totals & 
Schedule tab.  

 

 

5 Select Move. 
 
 
 
 
 
 
 
 

6 From the Pay Code drop-down 
list select the Comp Time Earn 
code where you will move the 
overtime hours. 
• The correct Comp Earn code 

will be applied by the system 
based on EClass. For 
example Comp 2 is used by 
CWA and Police Bargaining 
units only. 

 
Verify the amount of hours which 
will be moved to the Comp Time 
Earn code. 
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Steps 

7 Select on the Comments button, 
select appropriate comment, add 
Note if necessary. 
 
Select OK 

 

8 Select OK 

 

9 Select on Actions, select 
Calculate Totals to preview the 
change.   

10 Select Save. 

 

Special Instructions:  
Moving amounts within LoboTime effectively requires that you make the move at the account level and 
that you designate the index that you are moving “to” (even if it is the same as the “from” index).  In 
addition, the date of the movement is very important.  Please read below to ensure this is done correctly. 
While LoboTime will allow managers to perform a moved amount from the Overtime (O/T) pay code to the 
Regular time pay code, the only moved amounts that should be made from the O/T pay code is to the 
Comp Time Earned pay code (if previously agreed to by the employee and their supervisor).  The Fair 
Labor Standards Act requires the University to pay employees for overtime worked regardless whether it 
was pre-approved in advance or not.  If overtime is worked but not pre-approved in advance, it must be 
paid at time and a half and addressed after the fact as a performance management issue.  Please do not 
perform any moved amounts from O/T to Regular time.  
Summary: Best Practice is to “Move” amounts within the “Totals & Schedule” section.  Additionally you 
will need to change the “Effective Date” to the exact date when the hours have been accrued.  In other 
words, change the effective date in the moved amounts dialog box. For a terminated employee this 
should be on or before the employee’s last day in the current pay period. 
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Viewing the Audit Trail 

Purpose 
The Audits tab is located at the bottom of the Timecard workspace. The tab lists all punches or amounts 
made to an employee’s timecard and approvals made by Supervisors or Time Managers. The tab also 
lists punches made from timestamping. You can view all data sources, or a specific data source, such as 
edits to a timecard. Within a timecard, you can view all edits or a specific type of edit, such as punch 
edits. You want to review all manual edits that have been made to an employee’s timecard. 

 

Column Description 

Date/Time The effective date and time of the edit 

Type The kind of edit that was performed 

Account The account to which the edit is attributed, if different from the primary account 

Pay Code/Amount The pay code and amount of hours to which the edit is assigned, if applicable 

Work Rule The work rule used with the edit, if different from the employee’s primary work rule 

Override The type of entry that this edit is replacing or canceling, if applicable 

Comment The comment attached to the edit 

Edit Date/Time The date and time the edit was made 

User The user name of the person who made the edit 

Data Source The component of the application from which the edit was made 
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Steps 

1 From a timecard, select the 
Audits tab. 

2 Select a type of edit or select All 
to display all types of edits from 
Type of Edit drop-down list.  

3 (Optional) Select the Data 
Sources arrow. 

4 In the Select Data Sources 
dialog box, select the source of 
the edit or leave it at the default 
All Data Sources to display all 
edit sources. Then select OK. 
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Steps 

Finalizing Timecards 

Reviewing Time Data at the End of the Pay Period 

Purpose 
The Pay Period Close widget helps you to identify timecard discrepancies at the end of a pay period so 
that you can perform final edits. You must correct all exceptions before time data is approved/signed off 
by departments and timecards are locked. Otherwise, employees may not get paid correctly for that pay 
period. 

Approving Individual Timecards 

Purpose 
After you finish editing your employees' timecards, you need to approve them, which is the first of two 
steps necessary to indicate to Payroll that they are ready for processing.  You can approve timecards 
from a widget or on a timecard itself. After you approve a timecard, the employee cannot make any edits 
to it unless you remove your approval.  

Example 
You notice that Rick CarterSU has approved his timecard for the current pay period. You have reviewed 
the employee’s time data and performed all necessary edits. You approve the employee’s time for the 
current pay period on his timecard. 

Steps 

1 From the Related Items pane, 
select  Pay Period Close. 

2 Select the specific set of 
employees from the Show drop-
down list. Select the specific time 
period from the Time Period drop-
down list. 
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Steps 

3 Select the employee, right-select 
and then select Timecard.  

 
4 Select Approvals > Approve. 

5 Do you want to check the approval 
status on the timecard or the Pay 
Period Close widget? 
 
To confirm the approval status on a 
timecard, select the Sign-offs & 
Approvals tab and review the 
Approval by Manager information 
 

 

 

 To confirm the approval on the Pay 
Period Close widget, select 
Refresh, and review the Manager 
Approval column. 

 

 

 

 

Tip 
You can remove your approval by following the same steps and selecting Remove Approval 
from the Approvals menu. 

 

 

 

Business practice 
Supervisors and Time Managers must approve AND signoff all timecards by 5pm on the Monday 
evening prior to the first payroll run, which pays the Friday of the same week.  
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Approving Multiple Timecards 

Purpose 
Once you have reviewed and updated your employees’ timecards, you can approve them all at once, 
rather than approving them individually. When you approve multiple timecards at once, use the Group 
Edit Results page to confirm that all of them are approved. If one or more of the timecards are not 
approved, the Details link on the Group Edit Results page identifies whose timecard was not approved 
and why.  

Example 
You have reviewed and completed final edits to your employees’ timecards. You will approve them all 
at once. 

Steps 

1 From the Related Items pane, 
select Pay Period Close. 

 

2 Select the specific set of 
employees from the Show drop-
down list. Select the specific time 
period from the Time Period 
drop-down list. 

 

3 Do you want to approve timecards 
for all employees or specific 
employees? 

• To approve timecards for all 
employees, select Actions > 
Select All. 

• To approve timecards for 
specific employees, hold the 
Ctrl key and select each 
employee. 

 

 

4 Select Approvals > Approve. 

5 Select Yes to confirm your 
approval. 
 

 

6 Do you want to check the 
approval status on the timecard or 
the Pay Period Close widget? 
To confirm the approval status on 
a timecard, select the Sign-offs & 
Approvals tab and review the 
Approval by Manager 
information.  
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Steps 

To confirm the approval on the 
Pay Period Close widget, select 
Refresh, and review the Manager 
Approval column. 

 

 

You can also review the group 
approval status by viewing Group 
Edit Results. Select the Back 
to… button. Select Group Edit 
Results.  

7 If the Group Edit Results indicate 
that some timecards are not 
approved, select the Details link 
in the Results column and review 
the reasons why. 
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Removing Your Timecard Approvals 

Purpose 
After you approve one or more employees’ timecards, they are no longer editable. If the need arises and 
you have the appropriate permissions, you can remove your approval. After you remove your approval, 
you can make the necessary timecard edits and then re-approve the timecards. 

Example 
You have been informed that an employee forgot to enter four hours of sick time for Wednesday of the 
current pay period. You have already approved the employee’s timecard. You need to remove your 
approval, add four hours of sick time for that Wednesday, and then re-approve the timecard for that day. 

Steps 

1 From the Related Items pane, 
select Pay Period Close.  

2 Select the specific set of 
employees from the Show drop-
down list. Select the specific time 
period from the Time Period 
drop-down list. 

 

3 Select the employee. 
 

 

4 Select Approvals > Remove 
Approval. 

5 Select Yes to confirm that you 
want to remove your approval. 

 

6 Do you want to check the status 
of your action? 
• You can review the group 

approval status by viewing 
Group Edit Results. Select the 
Back to… button. Select Group 
Edit Results. 

• To confirm on a timecard that 
the approval is removed, select 
the Sign-offs & Approvals tab. 
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Business practice 
If an employee has already approved their timecard, and it is necessary to make changes to 
the timecard, the Time Manager/Supervisor should communicate changes made to the 
timecard back to the employee. 

Signing Off Timecards 

Purpose 
Signing off prevents unauthorized users from making additional edits to timecard data, which ensures 
accurate payroll processing. Before you sign off the data and begin payroll processing, you should 
perform a final validation of the timecard. After sign off, you can make no further edits to timecard data, 
including removing an approval. This restriction reduces the number of last-minute changes while you 
prepare to process payroll.  
It is recommended as a best practice that timecards are signed off from a timecard although the system 
allows you to sign off from a Genie.  

Example 
It is the end of the pay period and you want to sign off employee timecards for your 
department/organization. You confirm the success of the sign off on the Group Edit Results page. 

Steps 

1 From the Related Items pane, 
select Pay Period Close.  

2 Confirm that the timecard(s) have 
been approved by reviewing the 
Manager Approval column. You 
might need to select Refresh to 
display the most current 
information. 

 

3 Do you want to sign off timecards 
for all employees or specific 
employees? 
• To sign off timecards for all 

employees who appear in the 
Pay Period Close widget, 
select Actions > Select All. 

• To sign off timecards for specific 
employees, hold the Ctrl key 
and select each applicable 
employee. 

 

  4 Select Approvals > Sign Off. 
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Steps 

5 Select Yes to confirm the sign off. 

 

6 Do you want to confirm the status 
of your sign off on a timecard or 
from the Pay Period Close 
widget? 

 To confirm the sign-off status on a 
timecard, select the Sign-offs & 
Approvals tab and review the 
Sign Off information. 

 To confirm the sign-off status from 
the Pay Period Close widget, 
select Refresh, and review the 
Signed Off column. 

 To confirm the status of a group 
sign off, select the Back to… 
button, select Group Edit 
Results, and then review the 
Signed Off information.  

 

 

7 If the Group Edit Results indicate 
that some timecards are not 
signed off, select the Details link 
and review the reasons why. 

 

 

Terminated Employee Business Process 
There are multiple ways that a job can end and the supervisor or time manager no longer sees them in 
their active lists in LoboTime after midnight on the day of the termination. It is recommended you make 
this a part of your bi-weekly and monthly process before each payroll deadline. 

Example 
It is the end of the pay period and you want to sign off employee timecards for your 
department/organization including terminated employees.  
 

Steps 

1 Employee Approval 
Employee needs to approve 
their timecard in LoboTime on 
their last day 
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Steps 

2 Manager Approval 
Supervisor or Time Manager 
to approve the terminated 
employee’s timecard in 
LoboTime on their last day 

  

 

3 Employee is terminated in 
Banner  
Confirm the employee is 

terminated in LoboTime as of 
midnight on the Job End 
Date in Banner.   

 

  

4 Sign-off on timecard for 
terminated employee 
Search for the terminated 
employee by selecting 
“Reconcile Timecard” or 
“SignOff Issues” in the 
“Manager Genies”  

 

5 Reconcile Timecard search 
Select the dropdown arrow to 
the right of “Show” > Select 
“Terminated Employees”  
 
Select the dropdown arrow to 
the right of “Time Period” > 
Select “Previous Pay Period” 

 
6 Time Manager Sign-Off 

Select terminated employee in 
the list > select Timecard > 
Sign-Off the terminated 
employee’s timecard in 
LoboTime by the Payroll 
Deadline.  

 

 

7 Cancel or Delete all future 
“Approved” leave requests 
from the Schedule Editor. 
Future leave request data can 
come through on payroll feeds 
so they should be deleted.  
Select Schedule Editor from 
the Manager Genie 
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Highlight annual leave > Right Click > Delete 

 

Early Payroll Deadlines and Projecting Future Time 

Purpose 
Early payroll deadlines are the same in LoboTime as they are in Banner Department Time Entry.  
 
Each department will need to establish a process for their department in order to meet the early payroll 
deadlines due to holidays and bank closures. 
 
For example, if there is an upcoming Friday, 5PM deadline for having time entered, approved and signed-
off in order to get their employees paid on time for a 2R bi-weekly pay period.  
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Guidelines for entering projected time in LoboTime due early payroll deadlines: 
Since employees cannot enter projected punches in LoboTime, it will be the responsibility of Supervisors 
or Time Managers to enter the hours. 

• If the expected sign-off by the manager will precede any hours that are scheduled to be worked, 
the manager will need to enter the time in the employee’s timecard for the projected hours through 
the last day of the pay period. 

• Highlight the applicable row in the timecard 
• A manager can do one of the following methods to enter hours in the timecard per the projected 

schedule: 
o Enter each In-Punch and Out-Punch time (you do not also need to enter a Pay Code) 
o Select "Save"   
o The applicable number of hours will populate in the Totalizer 

OR 
o The system will allow a user to enter a Pay Code and total estimated hours worked for 

each day (rather than entering in/out punches), however be aware that if you use this 
technique, Overtime hours and Worked Holiday Hours @ 1.5 may not calculate.   

o Select the correct Pay Code based on the employee’s EClass in Banner 
o E.g. for SN staff use “Regular Base Pay Shift” from the drop down menu in the Pay Code 

column 
o Enter the number of hours within the “Amount” column. 
o Select "Save"   
o The applicable number of hours will populate in the Totalizer 

 
• Please Note:  

o Sign-offs cannot be removed after the payroll deadline has passed. If a change to an 
employee’s time is necessary a Payroll Adjustment Form will need to be submitted in order 
to change the employee’s timecard data. 

o If time has been projected the employee should NOT record their time using a PC or Clock 
on these days. 

 
To accommodate for this early deadline, LoboTime will allow for an early sign-off within the current pay 
period typically starting on a Wednesday, at 9am through 5pm Friday deadline day.   
 
An out-punch on the early deadline Friday may need to be estimated/projected for employees that are 
working this day.  
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An evaluation of hours worked versus hours reported should be completed: 
• For time that was understated or for missed hours managers should use the “Missed Shift 1, 2, or 3 

Prior Hours” pay code in the timecard for the next open pay period. 
• Use Pay Code “Missed Shift 1 Prior Hours”  
• Use Pay Code “Missed Shift 1 Prior OT @ 1.5”  
• Use applicable shift when selecting the Pay Code from the drop down list in the timecard. 

 
• For time that was overstated a manager should submit a payroll adjustment for the difference in hours. 

Holiday Leave  
Guidelines for projected time working on a Holiday:  

• If not projecting time, no additional action is required. 
• Employee chooses up-front to receive holiday hours in addition to their scheduled work hours 

and they are not deferring holiday hours to another day. 
• Select the "Add a row" button on the same day as the holiday 
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• Enter in-punch(es) and out-punch(es) for the projected scheduled times (you do not also enter 

a Pay Code) 
• Pay Code for “Worked Holiday Shift @ 1.5” will automatically populate in the Totalizer 
• Pay Code for Holiday Leave will automatically populate in the Totalizer 

Holiday Hours Deferred 
Employee chooses up-front to take their Holiday hours on another day: (Defer holiday hours to another 
day) If not projecting time, skip to step 4 for example if an employee’s normal day off per schedule falls 
on a UNM Holiday. 

• "Add a row" on the same day as the holiday 
• Enter In-Punch and Out-Punch out for the projected scheduled times (do not enter a Pay Code) 
• Pay Code for “Worked Holiday Shift @ 1.5” will automatically populate in the Totalizer 
• "Add a row" on the same day as the holiday 
• Select “Holiday Leave” from the drop down menu in the Pay Code column on the newly added 

row  
• Enter the number of hours with a negative (dash) in the “Amount” column. 

 Note: This should be the only time you use a negative amounts to correct 
timecards 

• Select "Save"   
• The applicable number of hours should populate for Holiday Leave in the Totalizer 
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Guidelines for entering Holiday Hours other than on a UNM scheduled Holiday: 
• "Add a row" in the timecard on the day the employee is taking their holiday hours 
• Select “Holiday Leave” from the drop down menu in the Pay Code column on the newly added 

row  
• Enter the number of hours within the “Amount” column. 
• Select "Save"   
• The applicable number of hours will populate for Holiday Leave in the Totalizer 

 
If an employee works an unscheduled shift on a designated UNM Holiday and the timecard has already 
been signed off the manager should submit a Payroll Adjustment Form.  
If you have questions on policy associated with holidays, please contact your HR Consultant. 
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Guidelines for entering Leave without Pay (LWOP) surrounding a UNM scheduled 
Holiday: 

EXEMPT: Entering LWOP in lieu of the holiday 
• "Add a row" on the same day as the holiday 
• Select “Holiday Leave” from the drop down menu in the Pay Code column on the newly added 

row  
• Enter the number of hours with a negative (dash) in the “Amount” column > Select "Save"   
• The applicable number of hours will populate for Holiday Leave in the Totalizer 
• Again "Add a row" in the timecard on the day the employee is using LWOP 
• Select “Leave without Pay with Benefits” from the drop down menu in the Pay Code column on 

the newly added row  
• Enter the number of hours within each cell under the date column in the timecard. 

 

 
• Select "Save" 
• The applicable number of hours will populate for “Leave without Pay with Benefits” in the 

Totalizer 
For Exempt Employees - The reduction of hours will be applied to the pay check that also reflects other 
exception time.  For example:  if an employee took LWOP on Monday November 18th it will be reflected in 
their December 20th check date. 
NON-EXEMPT Encountering an Unexcused Absence before or after the holiday: 
If an employee does not work the scheduled day before the holiday  

• The LWOP Earn/Pay Code should be used only if the employee elects “Leave without Pay” 
instead of using “Sick” or “Annual”.  

• If the department does use LWOP instead of an unexcused absence the above instructions 
need to be used to back out the holiday hours.   

• Print the Time Detail Report and have the employee sign the timecard for acknowledgment of 
any unexcused absences for documentation purposes. 

• It is highly recommended that the day be left as an “Unexcused Absence” in the timecard which 
is identified by a red outlined box around the day. 
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Please Note: (for both Exempt and Non-Exempt): 

• If an employee has LWOP the scheduled day before or the day after the holiday they are not eligible
for the holiday hours.

• Only enter LWOP for intermittent leave in LoboTime, do not use the Earn/Pay Code when the employee
is on “B” status in Banner.

• As a general rule, intermittent LWOP is entered on the day that it is used.
• For excused absences use “Sick” or “Annual” leave as appropriate.

If applicable Holiday hours are showing as “0” in the timecard for “Next Pay Period”: 
• At the start of the pay period which includes the holiday, the “Holiday Leave” pay code will populate in

Non-Exempt timecards. 
• For employees with a schedule, once the hours have been projected and entered for the day before

the holiday it is expected the “Holiday Leave” hours will also populate in their timecards on the 
applicable days.   

• If the hours are still not populating, enter a punch on the next scheduled day after the holiday. For most
employees it is necessary to enter their projected typical In-Punch time according to their schedule. 

• Please contact  LTPAY@unm.edu immediately if you are still not able to see the holiday hours in each
timecard.  

• Do not sign off on timecards if the holiday hours are not displaying or calculating correctly.

Navigating the Schedule Editor 

Purpose 
LoboTime includes the Schedule Editor where you schedule worked and non-worked hours. Using the 
Schedule Editor, you can: 

• Add, edit, and delete shifts
• Add pay codes for worked or non-worked hours
• Schedule labor transfers

mailto:%20LTPAY@unm.edu
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Areas Description 

Name column Lists the employee names. 

Sch Hrs. column Displays total number of scheduled hours by employee for the selected time period, 
with lunch deducted if applicable. 

Date cells For each day in the selected time period, displays shift start and end. A date cell can 
also display pay codes to identify scheduled non-worked hours. 

Scheduled Hours 
row 

Displays total number of scheduled hours for all employees for the selected time 
period and for each date displayed. 

Number of 
Employees row 

Displays the total number of employees used to calculate total Scheduled Hours. 

Tip 
Schedule Editor builds a schedule pattern.  The pattern is built on the “person”.  An example of 
a schedule pattern is 9a – 5p Monday – Friday. 
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Steps 

1 From the Related Items pane, 
select Schedule Editor. 

2 Select All Home from the Show 
drop-down list to view all the 
employees you are authorized to 
view. 

3 Select the specific time period 
from the Time Period drop-down 
list. (The default is Current 
Schedule Period.) 

Creating Schedules Using Pattern Templates 

Purpose 
Schedule patterns let you quickly apply a set of shifts to employees who work the same shifts on a 
regular basis. A schedule pattern consists of one or more shifts that repeat over a specified time period. 
When you create schedules for employees who have a schedule pattern, you can add the shift days and 
times manually or use a predefined pattern template. The pattern template defines the pattern of the 
shifts’ days and times and makes it easier and faster for you to create the employees’ schedules. 

Example 
You want to permanently schedule Raul SanchezSW to work  9:00 A.M. to 2:00 P. M. Monday through 
Friday every week, starting Monday of the current schedule period. You know that a pattern template 
exists that defines this schedule pattern, so you will use it because it is easier and faster than adding the 
schedule manually. 
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Steps 

1 From the Related Items pane, 
select Schedule Editor. 
Select the specific set of 
employees from the Show drop-
down list. Select the specific time 
period from the Time Period 
drop-down list. 

2 Select the Raul SanchezSW who 
you will schedule using a pattern 
template. To select multiple 
employees, hold the Ctrl key and 
single-select each employee’s 
name.  

3 Select Shift > Add Pattern   
(To update or change a pattern 
previously built in a prior pay 
period follow the instructions 
above to add a new pattern. 
Selecting the “override other 
patterns” will replace the old 
pattern with the new pattern) 

4 Select Insert Pattern. 

5 Select a pattern from the list and 
select OK. 

6 From the Work Start Date drop-
down list, specify the effective 
date on which the employee(s) 
starts working the pattern. 

7 From the Pattern Start Date 
drop-down list, specify the 
effective date on which the pattern 
starts. 

8 From the End Date drop-down 
list, specify the last date the 
pattern will be effective. To have 
the pattern in effect with no end 
date, select Forever. 

9 Select OK > Save > Refresh 
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Tip 
Work Start Date and Pattern Start Date will be the same date. 

Refreshing and Saving Data 

Purpose 
When you add and modify schedule data, the application displays your edits but does not save them 
automatically. You must tell the application to save the data. Prior to saving your data, you can cancel 
your edits if necessary. 

Visual indicators 
When you edit a schedule, the page name turns orange and an asterisk appears next to it to let you know 
that your edits are not yet saved. After you save, the visual indicators no longer appear. 

Canceling edits 
The application does not save your edits until you tell it to do so. Until that time, you can remove or cancel 
your edits using the Refresh button. When you select Refresh, the application redisplays the most 
recently saved information, overwriting all of your unsaved edits. 

Saving edits 
When you are satisfied with your edits, you must save them. If you close the employee’s schedule before 
you save the edits, they are not saved. 

Canceling edits 

Steps 

1 Perform your edits to a schedule. 
Note the visual indicators that 
indicate unsaved data. 

2 Select Refresh and review the 
schedule information. 

3 Do you want to cancel your 
changes? 
• To cancel your changes, select

Yes. 
• To keep your changes, select

No. 
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Saving edits 

Steps 

1 Perform your edits to a schedule. 
Note the visual indicators that 
identify unsaved data. 

2 Select Save. 

3 Review the employee’s schedule 
to ensure that the visual indicators 
no longer appear, validating that 
your information was saved. 

Tip 
Remember the data in Schedule Editor does not automatically save, you must save your data 
to record your work. 

Adding Shifts by Inserting a Shift Template 

Purpose 
You can add a shift by entering the start and end times directly into the date cells in the Schedule Editor. 
If the shift times are standard for The University of New Mexico, you might have a shift template that you 
can use. Shift templates define the start and end times of standard shifts that employees work regularly. 
A shift template does not include specific days or dates.  

Example 
You review your workload and notice that you need your employee, Raul SanchezSW, to work the 8:00 
A.M. to 12:00 P.M. shift on second Monday and Tuesday of the current  schedule period. You know that 
there is a shift template that defines the start and end times for this shift. You will insert the shift template 
when you schedule one of your employees to work the shift.  

Steps 

1 From the Related Items pane, 
select Schedule Editor. 

2 Select the specific set of 
employees from the Show drop-
down list. Select the specific time 
period from the Time Period 
drop-down list. 

3 Locate the employee’s row and 
select the cell in the row and 
under the date where you want to 
add a shift.   
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Steps 

4 Select Shift > Add 

5 In the Shift Editor, confirm that the 
correct employee’s name appears 
in the Employee field and the 
correct scheduling date appears 
in the Start Date field. 

6 Is there a shift template available 
for this shift assignment? 
• If a shift template is available,

select Insert Shift. Select the 
appropriate shift and select OK. 
Continue to step 11. 

• If no shift template is available,
continue to step 7. 

7 From the Type drop-down list, 
select the shift type for the first 
segment. 

8 In the Start Time field, enter 
when the shift begins and press 
Tab. 

9 In the End Time field, enter when 
the shift ends and press Tab. 

10 Confirm that the date in the End 
Date field is correct. If the shift 
segment crosses a day divide, 
change the shift’s end date to the 
following day. 
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Steps 

11 Confirm that the amount in the 
Sch Hrs column equals the total 
hours for this segment. 

12 Do you want to add additional 
segments to this shift? 
• To add additional segments, for

each additional segment, select 
the Insert Row icon and 
complete steps 7–11. 

• To add no additional segments,
continue to step 13. 

13 Enter the number of days you 
want to schedule this shift. 

14 Select OK and then select Save. 

Tip 
You can enter time using either 12-hour or 24-hour time formats. For example, you can enter 
8:00 A.M to 5:00 P.M. as 0800-1700 or 8a-5p. The configuration of the system determines the 
default time format. You can also copy and paste shifts using Ctrl-C and Ctrl-V. 

 
Business practice 
Always look for a shift template first when scheduling employees’ shifts.  Several shift 
templates have been created. If a shift template is not available, the recommendation is to key 
the data in as needed. 
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Editing Shifts Using the Shift Editor 

Purpose 
When creating and editing more complex schedules use the Shift Editor. It has tools that make it easier 
for you to create and edit shifts with several segments, shifts with transfers, shifts that cross the day 
divide, and other complex shifts. 

Example 
On the first Friday of the current schedule period, you need Raul SanchezSW to work the following shift 
segments: 

• Regular shift from 8:00 A.M. to 12:00 P.M.
• No break

Use the Shift Editor to add the shift to the employee’s schedule for the first Friday of the current schedule 
period.  

Steps 

1 From the Related Items pane, 
select Schedule Editor. 

2 Select the specific set of 
employees from the Show drop-
down list. Select the specific time 
period from the Time Period 
drop-down list. 

3 Locate the employee’s row and 
select the cell in the row and 
under the date where you want to 
add a shift.   

4 Select Shift > Edit 

5 In the Shift Editor, confirm that the 
correct employee’s name appears 
in the Employee field and the 
correct scheduling date appears 
in the Start Date field. 
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Steps 

6 Is there a shift template available 
for this shift assignment? 
• If a shift template is available,

select Insert Shift. Select the 
appropriate shift and select OK. 
Continue to step 11. 

• If no shift template is available,
continue to step 7. 

7 From the Type drop-down list, 
select the shift type for the first 
segment. 

8 In the Start Time field, enter 
when the shift begins and press 
Tab. 

9 In the End Time field, enter when 
the shift ends and press Tab. 

10 Confirm that the date in the End 
Date field is correct. If the shift 
segment crosses a day divide, 
change the shift’s end date to the 
following day. 

11 Confirm that the amount in the 
Sch Hrs column equals the total 
hours for this segment. 

12 Do you want to add additional 
segments to this shift? 
• To add additional segments, for

each additional segment, select 
the Insert Row icon and 
complete steps 7–11. 

• To add no additional segments,
continue to step 13. 

13 Select OK and then select Save. 
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Editing Scheduled Shifts in Cell Editing 

Purpose 
When events in employees’ lives occur that require them to take time off and when your workload 
requirements vary, you will need to change employees’ schedules. You need to keep the schedules 
accurate to reduce the number of exceptions that might appear in employee timecards. 

Example 
Your workload requirements have changed on Wednesday of the second week in the current period.  
Raul SanchezSW has volunteered to change his schedule to satisfy the new requirements.  Change his 
regular shift to 8:00 A.M. to 12:00 P.M. 

Steps 

1 From the Related Items pane, 
select Schedule Editor. 

2 Select the specific set of 
employees from the Show drop-
down list. Select the specific time 
period from the Time Period 
drop-down list. 

3 Locate the employee’s row and 
select the cell in the row and 
under the date that contains the 
shift that you want to edit. 

4 Edit shift start and/or end times 
and press Tab. 

5 Select Save. 
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Deleting Shifts from Employees’ Schedules 

Purpose 
Employees sometimes are unable to work a scheduled shift. When this happens, you need to delete the 
shift from the employee’s schedule to prevent the application from flagging the employee as absent 
without an excuse. 

Example 
Julie ChangST mentioned that she will be unable to work  Monday of the schedule period because she 
needs to attend her brother’s out-of-town wedding. Access the Schedule Editor and delete the 
employee’s schedule for  Monday of the schedule period. 

Steps 

1 From the Related Items pane, 
select Schedule Editor. 

2 Select the specific set of 
employees from the Show drop-
down list. Select the specific time 
period from the Time Period 
drop-down list. 

3 Locate the employee’s row and 
select the cell in the row and 
under the date that contains the 
shift you want delete. (In this 
exercise you will select Judy 
ChangST.) 

4 Select Actions > Cut. 

5 Select Save. 
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Restoring Deleted Shifts 

Purpose 
If an employee’s plans change or a shift was deleted in error, you can restore the shift if it belongs to a 
pattern. Use the Restore feature on the Actions menu to insert the original shift into the employee’s 
schedule. 

Example 
Julie ChangST’s plans have changed and she will be able to work the Monday of the next schedule 
period after all. Access the Schedule Editor and restore the shift in the employee’s schedule for Monday 
of the next schedule period. 

Steps 

1 From the Related Items pane, 
select Schedule Editor. 

2 Select the specific set of 
employees from the Show drop-
down list. Select the specific time 
period from the Time Period 
drop-down list. 

3 Locate the employee’s row and 
select the cell in the row and 
under the date where you want to 
restore the shift. 

4 Select Actions > Restore. 

5 Select Save. 
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Steps 

5 In the Effective Date field, 
confirm the date selected. (Or, if 
incorrect, enter the correct date.) 

6 From the Pay Code drop-down 
list, select the pay code. 

7 In the Amount field, do one of the 
following: 
• To schedule a specific number

of hours, enter the amount of 
hours in the field 

• To schedule the entire number
of hours the employee is 
scheduled to work that day, 
select full sched day from the 
drop-down list 

• To schedule half of the number
of hours the employee is 
scheduled to work that day, 
select half sched day from the 
drop-down list 

8 (Optional) If the non-worked hours 
must replace the employee’s 
existing shift, select the Override 
Shift check box and do one of the 
following: 
• To override the employee’s

entire shift, select Whole Shift 
• To override part of the

employee’s scheduled shift, 
select Partial Shift 

9 In the Start Time field, enter the 
effective time for the non-worked 
hours. If the employee already 
has a schedule, the shift start time 
is the default. 

10 In the Repeat for (D) field, enter 
the number of consecutive days 
this edit applies. For example, if 
the employee has requested five 
consecutive days of vacation, 
enter 5. 

11 Select OK and then select Save. 
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Minutes reported Rounding to tenth
Real time 
example Rounded to

1-3 min 0=0 min 8:03 AM 8:00 AM
4-9 min 0.1=6 min 8:04 AM 8:06 AM
10-15 min 0.2=12 min 8:11 AM 8:12 AM
16-21 min 0.3=18 min 8:23 AM 8:24 AM
22-27 min 0.4=24 min 8:26 AM 8:24 AM
28-33 min 0.5=30 min 8:35 AM 8:36 AM
34-39 min 0.6=36 min 8:39 AM 8:36 AM
40-45 min 0.7=42 min 8:46 AM 8:48 AM
46-51 min 0.8=48 min 8:54 AM 8:54 AM
51-57 min 0.9=54 min 8:55 AM 8:54 AM
58-60 min 0.1=the next

Modification of Leave after Approval
Steven Knox, a non-exempt employee, submits 8 hours of annual leave for Monday. Throughout the course 
of the week he ends up working extra hours and no longer wants to use all 8 hours of Annual leave. Rather 
than cancel the request and require the employee to submit a new one, which must be approved before 
the Payroll deadline, the manager may modify the leave.  
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Navigate to the SCHEDULE EDITOR and locate the day that contains leave. 

Select on the cell where the Leave is located > Right Select > Select “Edit” > Select “Pay Code” 

Update the hours to the correct amount in the “Amount” field. 
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Add a comment indicating why the hours are being changed. Then select “OK” > select “Save” 

Notice the timecard will now reflect the updated amount of leave and leave banks will be recalculated. 

Modification of Leave Upon Approval 
Sally Edwards submitted a leave request for two days. She indicated the total leave to be taken of 16 hours 
in the “length” column instead of 8 hours each day. Managers may update leave requests upon approval.  
Select on the “approve button.” This will open the approve time-off request window. Select on “edit” located 
above the comments. 
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The following view will display: 

The length of time and any other necessary fields may be modified. Once all appropriate fields have been 
updated, add a comment and then select “Approve”.  

Ending Schedules/Breaks between Schedules 
Patterns may need to be ended or have a break between the old one and the new one. Patterns are built 
in pay periods and once the pay period has been signed off on the pattern cannot be deleted. Instead the 
pattern will need to be ended to allow for changes. 
Go to the schedule editor and select the individual whose pattern needs to be updated. Select on “shift” 
and “edit pattern.” The pattern editor will pop up.  
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Change the radio button from forever to “end date.” Add the end date, which must be the last day of the 
last pay period signed-off or later.  

Two warnings will display. Select “yes” for both of them. 
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Save your changes in the SCHEDULE EDITOR. A new pattern may now be created going forward. Please 
see “Scheduling Employee’s” for instructions. 

Using Online Help 

Purpose 
LoboTime contains an online Help system to help you perform Navigator or timekeeping tasks. It contains 
contents and search capabilities. 

Steps 

1 Access the Get Support 
workspace.  
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2 Use the tabs to locate online help 
data.  

Component Description 

Contents Collection of topics 

Search Tool for entering a specific word or phrase; topics appear with percent rankings 
that identify their relevance 
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Rounding to the Nearest 10th of an Hour 
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